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Chapter I: Introduction

Lawyers, Computers and the Internet

For lawyers, the computer revolution began about twenty years ago with the advent of

word processors and mini-computers followed in 1982 by the introduction of the personal

computer. The second wave of that revolution - the explosion in global computer

networking - began (for lawyers, that is) only about five years ago.

In the pre-Windows and pre-World Wide Web days (less than a decade ago) using

computers and communicating with other computers was difficult for a non-technical

person.  With the phenomenal technological advances in computer processing power,

memory, disk storage and software, computers and communications have become much

more sophisticated - and much easier to use.

The explosion in computer technology and the Internet is having a profound impact on

the way we practise law:

• Printed case reports, statutes and research tools will likely become prohibitively

expensive or be discontinued altogether as electronic versions take over the legal

marketplace. If you are not able to use these electronic services yourself, you will

have to find someone who is able.

• E-mail is becoming as essential as the fax and telephone. Clients are demanding it.

• With the huge cost savings to governments of distributing information and forms on-

line and enabling e-filing of securities, tax, corporate, trade-marks, patents and (soon

for Saskatchewan) land-titles documents, traditional means of communicating with

government via paper are disappearing.  Law offices must implement the technology

in order to practise in these areas.
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“But computers and the Internet are so complicated - I’m not a technical person”.

People are complicated too - much more complicated than computers.  Each cell in your

body is more complex than any computer in existence.  The workings of human brain, the

physiology of human speech, hearing, and the intricacies of human language are not

understood by most of us.  Nevertheless, we are able to speak, write, and read and we can

understand each other.  Don’t be intimidated by the technology. You don’t have to

understand it - you just have to know how to use it.

In this one day course, we hope to do the following:

1. to give you an overview of the technology and explain basic concepts in a non-
technical way;

2. to acquaint you with basic computer and Internet functions that will enable you to
find and use legal information resources;

3. to identify some important and useful electronic legal resources and how to access
them;

4. to give you a hands-on guided experience with the technology and finding legal
resources;

5. to let you practice the skills and knowledge you have learned.

The Explosion of Cyberspace

Computer networking began in the early 1970’s led by a group of American universities1.

The concept of a world-wide network gradually evolved and was significantly developed

by the Department of National Defence through the 1970s and 1980s.  The very useable

Internet - the World Wide Web - is only about eight years old.  Widespread use by the

public started less than five years ago.

                                                
1 the first packet based communication between two computers was achieved at UCLA in late
1969: R. Zakon, Hobbes' Internet Timeline: http://www.isoc.org/guest/zakon/Internet/History/HIT.html
See also: Vinton Cert, How the Internet Came to Be, (1993) Bell Labs : http://www.bell-
labs.com/user/zhwang/vcerf.html

http://www.isoc.org/guest/zakon/Internet/History/HIT.html
http://www.bell-labs.com/user/zhwang/vcerf.html
http://www.bell-labs.com/user/zhwang/vcerf.html
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The Internet is rapidly becoming the single largest medium of communication in the

world.  The web is changing the way commerce is conducted.  It has become the medium

of choice of governments and other organizations for locating, distributing and sharing

information.  Stock values of Internet companies are skyrocketing.  The Internet has

captured the world’s imagination.

And it is changing the way we practise law.
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Chapter II : Computers

Computer basics

A computer is an elaborate electronic switching device.  You don’t have to understand

how this makes it “think”.  Without wishing to start a metaphysical debate here,

computers do not think - they simply regenerate, very quickly, the thought processes of

programmers.   A human being is a self aware, self-reproducing, critical, creative and

emotional being; a computer has none of these attributes.  Like a parrot – it has no ability

to understand the information it processes.  It is a machine based on a concept which, at

its heart, no more sophisticated than a light bulb and a light switch.

Light bulbs and switches can seem complicated.  Imagine an elaborate Christmas light

display with millions of lights arranged in intricate patterns and arrays - displaying

shapes of animals, buildings, people; displaying messages, flashing, moving, and

pointing directions - all of which can be switched on and off at will from a single control

panel.   A “show” consists of a series of switching events that cause the light arrays to be

switched on or off to provide a message or experience for human observers.  The person

operating the switch control panel has a piece of paper (the program) that lists the

instructions for switches to be turned off or on and the order, time and duration of

switching.  The operator executes the program.  The viewers see the show.

The display of lights, complex as it may seem, is all built on a simple principle: turning

light bulbs on and off.  So it is with a computer - an elaborate, fast “thinking” machine

employing amazing technology but built on a simple principle.

Input and Output: Keyboard, Mouse and Screen

In order for a human being to communicate with a computer, information must be input

from the human to the computer and output from the computer to the human.  That is

what the keyboard, pointing device (mouse), screen, and speakers are for.
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We did not always have keyboards and pointing devices.  Early computers used punch

cards and ticker tape for input.  We did not always have video display terminals (VDT’s)

or speakers.  Early computers used teletype machines and matrix printers to display

information for the user.

The keyboard sends electronic codes to the computer corresponding to the letter or

character typed (each keyboard character has a numerical equivalent from 0 to 255 as

defined by the ASCII - American Standard Convention for Information Interchange).

A mouse is a pointing device which tells the computer the co-ordinates (vertical and

horizontal position) on the VDT screen which the user has selected. The computer

program that is running when the mouse is clicked receives that information and uses it in

some way.

The VDT informs the human user what is available on the computer and what the

computer is doing.  The computer displays text and graphics in forms and shapes that

humans understand.  With a speaker system installed, the computer can also send sounds

to inform the user.

Exercises

Play with your computer input devices.

 Click different areas or objects on the screen with your mouse and see what

happens.

 Open a word processor program like Wordpad and press keys on your

keyboard.  Type something intelligible and print it.

CPU, Memory (RAM) and Information Storage

A computer processes information and it stores information.  These are two very

different functions.  The Central Processing Unit (CPU) 2 and Random Access Memory

                                                
2 The CPU is an elaborate device that performs operations on electronic data in accordance with
electronic instructions.
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(RAM) are used when the computer is executing programs or “thinking”.  Storage

devices (hard and floppy disk drives and Compact Disc drives, for example) store and

permit retrieval of information.  In order to process information, the CPU must have the

information placed in RAM.

Imagine your desk when you are working on files.  You are working on one file at a time.

The information in the file you are working on is being read and your brain is processing

the information contained in it.  Your eyes scan the page and the brain interprets text

which says “please respond by Friday”. This causes your brain to direct your hand to grab

the dictaphone and dictate a letter.  When the letter is sent, the printed copy is placed in

the file and stored. Your thought processes having been recorded, you rid your mind of it,

close the file and open the next one.  Computers process and save information in

analogous ways – and that is all you really have to know.

The Importance of Saving

Your mind can forget things easily – that is why we write things down. Once

written down, the information can later be reloaded into the brain by reading it. If

you “turn off” your brain before you write its contents down, you may lose the

product of your thinking but you might remember all or part of it. Computers are

not as gifted.  If you turn off a computer before you have placed the information

into storage (by “saving” to your hard disk) the RAM loses all of its information

and your computer will remember nothing at all. You will have lost all of the

computer’s thinking since the last “save”.

Peripheral Devices

Microphones, light pens, scanners, and bar code readers can allow other forms of

information to be input into the computer.  Devices such as printers, modems, tape drives,

graphics plotters, CD writers, and (yes) scent generators allow the computer to provide

information output in different forms. These are just different devices for inputting and

outputting information to and from the computer.
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Programs - Software

A program is a set of instructions that are fed by the computer hardware to the CPU. (The

instructions in the program may change depending on the output from previous CPU

operations)3.  Programs are not “hardwired” into the computer hardware.  Hence the term,

“software”.

There are different “levels” of programming.  Some programmers write instructions to be

executed directly by the CPU.  These types of programs are very technical and require an

understanding of how the CPU works.  Simple operations, such as inserting a word in a

text string, can involve dozens of instructions.  Programming at “machine level” is like

writing a story in which each word has to be replaced by its dictionary definition.  Most

programmers work in higher level programming languages that use terms more easily

recognized by humans which, when “compiled” by other programs, generate the more

verbose instructions required by the CPU.

Operating Systems

In order to use a computer, the user must be able to store, retrieve and execute application

programs, save and retrieve data, and operate devices such as CD-ROM drives, printers,

modems etc.   The computer comes with a set of operating programs that allow the user

to operate the computer hardware and execute applications.  These operating programs

are known collectively as the operating system.

Boot-up

When you turn on your computer, it goes through a process of loading the operating

system.  In effect the computer “picks itself up by its bootstraps” - hence the term “boot-

up”.  During boot-up, the system follows program instructions that tell it everything it

needs to know about the devices that are present and how to communicate with them:

                                                
3 A simple CPU operation might be: “take the data in register D1 and perform the operation
described in register A1 on data in register D2 and place the output in register D3”.  If register A1
contains the instruction code for “add”, the numbers in D1 and D2 are added and the sum placed
in register D3.  The actual “instruction set” for a chip depends on the chip design:  Intel chips
(used in PCs) and Motorola chips (used in Apple computers) use different instruction sets.
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how to display information on the screen, how to print, how to find information on the

disk, and how to run programs.  This process takes a few minutes.

The User Interface: DOS vs. Desktop

Once the computer is booted up, the user is able to interact with the computer. Since

humans are not machine-like and computer are not human-like, the information the user

inputs and the information which the computer outputs have to meet a common interface

that both understand.

Earlier operating systems (such as MS-DOS) consisted of programs that were technically

simpler than those found in modern graphical operating systems (such as Windows). But

they were, generally, not simple to use.  The DOS user had to know DOS commands and

type them (correctly) at the DOS prompt (usually a C:> ). These character-based

interfaces were useable so long as the functions needed were limited.

With a graphical user interface (GUI) such as Windows, MacIntosh, UNIX, LINUX and

others, it is much easier for human beings to see what is on the computer, to locate and

move information, and to run applications. The user points and clicks on pictures,

buttons, menus, text and symbols rather than typing complicated commands.  Those

mouse clicks generate character commands that execute functions in a DOS like way, but

the user does not know or care.

The Windows Desktop

Once booted, the Windows 95/98/NT operating system presents its “Desktop” screen to

the user. The Desktop is just a graphical presentation of information and programs

residing on the computer.

There are a few very basic features and functions that you should know before being able

to use the computer (we will assume you are already familiar with the operation of a

keyboard):
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• Mouse clicking:

 Single clicking:  to select

 Fast double clicking: to execute

 Right mouse button: to bring up menus

• The “Start” button (lower left): click on (or press the Windows key on your keyboard)

 The Start Menu: shows some main functions available on your computer

 The Program Menu:  lists all the programs available on your computer

 Other functions such as Help, Documents, Settings, Finding files

• The “Desktop” Icons

 Icons represent “shortcuts” to programs:  to execute the program, double click on

the Desktop icon

 Folders contain programs, document files or files containing data. To view a

document file in a folder, double click on the folder icon to display files and

double click on the document file.

• The “Taskbar”

 This is the gray bar that stretches across the bottom of your “desktop” screen.  It

contains icons for the programs that are open or active.  When you have two or

more active programs, you may switch from one to another by simply clicking on

the Taskbar Icon.

Folders and Files

Windows allows the user to organize information in the computer storage area, the hard

disk.   The information on the disk is structured in folders and files.

A file is a collection of connected information.  A word processing document, a spread-

sheet, a database, and a program are all stored in files. A folder is a collection of related

files (i.e. files that relate to a common subject or function). Folders are used to organize

files. A sub-folder is a sub-group of files within a collection of files.
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The folders and files that reside on your computer may be viewed using the “Windows

Explorer” utility program.

The Windows Explorer program allows the Windows user to see the information on the computer
disk(s).  The window on the right shows the files and folders contained in the selected drive or
folder on the left::

Exercise

 Invoke Windows Explorer and see your folders and files (select Start >

Programs > Windows Explorer)

 Double click on folders (on the left) to see files and sub-folders (on the right)

 Note the “tree” structure of the files and folders.

 Select the icon (on the left) for the C: drive (i.e. place the mouse over the icon

and click once with the left mouse button): click the right mouse button and

select “Properties” in the pop-up menu to see the space available and space

used on the drive.
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Creating folders

Folders may be created easily from Windows Explorer or from most application

programs. Folders must have a name.  You should choose names that tell you what is in

the folder (e.g.:  Client_documents or Legal_Research).

Exercise

 Create a folder and name it “Research”

 Invoke Windows Explorer and see your folders and files (select Start >

Programs > Windows Explorer)

 Click on the folder (left side) named “My Documents”

 From the file menu (top) select File>New>Folder

 Insert the word “Research” by typing over the words “New Folder”

 Observe the new folder icon “Research” below the “My Documents”

folder on the left side.

Create a new sub-folder of the “My Documents” folder in Windows Explorer . Name it “Research”
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Creating files

The Windows operating system allows the user to create files easily and in several ways.

Usually, the user creates files by saving work from an application, such as a word

processing program.  Files can also be created directly with utility programs such as

Windows Explorer.

A file needs a name.  The name has two parts: the File Name and the File Extension (or

Type).  The two parts are separated by a period (.).  Under Windows 95/98/NT, file

names and extensions can have any number of characters.  In the older DOS system,

names were limited to an 8 character file name and a 3 character extension.  Examples of

file names:  myfile.txt or what_I_did_on_my_summer_vacation.doc_1999

Exercise

 Create a text file, add the text and save the file.

 Invoke Windows Explorer and see your folders and files (select Start >

Programs > Windows Explorer)

 Click on the folder (left side) named “Research” under “My Documents”

 From the file menu (top) select File>New>Text Document

 You will see a new file called: New Text Document.txt

 You may insert your own file name by typing over the words “New Text

Document.txt”.   Type the file name:  “junk_file.txt”

 Double-click on the icon just to the left of the file name to bring up the

Notepad program

 Type some text in the “Notepad” window

 Save the file by selecting File>Save from the menu bar.

 Exit the document: File>Exit

 Go back into the Document by double-clicking on the file name

(junk_file.txt) in Windows Explorer.  You will see the text you just typed

and saved.

 Exit the document again  File>Exit
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Moving Files and Folders

Files and folders can be copied or moved around on a hard drive or copied to other

drives.  Utilities in the Windows operating system make this very easy to do by “dragging

and dropping” them from one location to another.

Exercise

 Move a file from one folder to another

 Invoke Windows Explorer and see your folders and files (select Start >

Programs > Windows Explorer)

 Click on the folder (left side) named “Research” under “My Documents”

 On the right window, select the file you just created in the previous

exercise (junk_file.txt) by pointing the mouse on it and clicking and

holding the right mouse button down.

 While holding the right mouse button down, move the mouse pointer over

to the left side of your screen on top of the folder “My Documents”.

 Lift the right mouse button.  A pop up-menu appears listing options of

Move or Copy.  Select “Move”  (click on the  word “Move” with left

mouse button).

 The file has been moved from the sub-folder “Research” to “My

Documents”.

 Reverse the operation by moving the file (“junk_file.txt”) back to the

“Research” sub-folder.

 Copy a file to another folder

 Repeat the above steps but select “Copy” from the pop-up menu.

 Note that the original copy in the “Research” sub-folder is still there and a

second copy is found in the “My Documents” folder.
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Moving or copying files in Windows Explorer.

Holding the right mouse button, “grab” and “drag” the file: “junk_file.txt” on the right over to the

“My Documents” folder on the left.  Select the “Move Here”  or “Copy Here” from the pop-up

menu.
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Chapter III : Networks

What is a Network?

A network is simply a group of interconnected, communicating entities: for example,

television networks, business networks, telephone networks, social networks.  A

computer network is a group of interconnected, communicating computers.

A local area network (LAN) can be set up in an office, say, to allow personal computers

to send and receive information to and from each other, to access common information

stored on “file server”, and to share printers and modems.   Such networks are connected

by common wiring and are very fast.  The standard business network - Ethernet - allows

users to transfer 10 to 100 millions of bits per second between computers (about 1-10

million characters per second).

A wide area network (WAN) to connect two or more LANs can be set up over long

distances through telephone or data communications channels.  Such networks are much

slower because they rely on relatively slow long distance communications lines.   WANs

use devices known as routers to handle the exchange of information packets between

LANs across the communications lines.

LANs and WANs use “packet technology”.  That is to say all communications between

computers on the networks is carried on by the transfer of discrete bundles of information

according to certain rules.  The structure of the packets and the rules used are defined by

the network “protocol”. There are many types of protocols:  NETBUI, IPX/SPX, TCP/IP,

Token Ring, DLC. In order to communicate, two computers must use the same protocol.

A computer network is similar in concept to the old pneumatic tube document transfer

systems found in many hospitals and some older office buildings in which canisters

containing documents are sent from one station to another.

Each computer “node” (or station) on the network has its own network address. The

sending computer places the network “address” of the destination computer on each
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packet it sends.  The receiving computer ignores all packets other than the ones which

have its address - like a person at a crowded party listening to one person and ignoring all

the other simultaneous conversations going on.

Networks can be complicated.  This is a network diagram of a LAN and WAN in Australia

The Internet

The Internet is a big WAN that is able to link thousands computer networks.  The success

of the Internet has been driven by three factors: reliability, accessibility and usability.

By the early 1990s, many if not most university and government networks were inter-

connected via the Internet.  The Internet had proven to be reliable and was in place all

over the world.  E-mail had become a common means of exchanging correspondence for

academics and governments around the world.  Entire computer archives were made

accessible to anyone on the Internet via easy-to-use menus known as “gopher” menus..

Searchable databases were developed to locate and index gopher sites.
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It was not until Tim Berners-Lee of CERN (a nuclear physics laboratory in Switzerland)

developed the concept of the World Wide Web that the Internet became widely

accessible and useable to casual computer users.   The idea behind the World Wide Web

was simple: connect information residing on computers around the world using

“hypertext” - text that contains a built-in link to another computer on the Internet.  The

hyper-link can be activated by a simple click on the highlighted text.

The growth in Internet use has been dramatic since the advent of the World Wide Web in

1992. With the development of Internet Browser4, programs, navigating the Internet

became as simple as pointing and clicking a mouse.

The following graph shows the growth of the Internet beginning in 1989:

The following graph shows the growth in sites on the World Wide Web since 1993:

                                                
4such as Netscape Navigator or Communicator and Microsoft Internet Explorer.  These
browsers can handle several types of transfer protocols (see page 16): http, ftp, e-mail,
news, telnet to provide information to the user without bothering the user with technical
details.
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No single computer runs the Internet.  If a computer that helps run the Internet is

unavailable, other computers take over.  As a result, the Internet is very rarely “down”.

The last Internet-crippling event was in 1988 when 10 percent of the 60,000 computers

then connected to the Internet went down as the result of sabotage by “hackers”.  The

likelihood that such widespread failure will occur again has been reduced dramatically

with improvements in computer security and by the number of computers that would

have to go down in order to have a material effect on the Internet.

Like other computer networks, the Internet uses an information exchange system by

which computers send and receive “packets” of digital information. Each packet has a

particular size and structure that is set by an international standard known as TCP/IP

(Transmission Control Protocol / Internet Protocol).

Specialized computers on the Internet known as Domain Name Servers (DNS) provide

“directory assistance”, looking up Internet addresses of the destination computer.  The

sending computer places this address on each packet it wishes to send to the destination

computer. Routing computers ensure that the “packets” are sent to the part of the

network to which the destination computer is connected. File servers connected to the

Internet store information and send it out on the Internet in response to a request from
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another computer.  Computers send information and requests back and forth using a

standard transfer protocol5.

The technical complexity of the Internet is not apparent to the user.  Using sophisticated

“browser” programs, the human user operates in an environment that he or she can

readily understand. Thus the Internet appears to the user as a world of data, text, still

images, sounds, and moving pictures, far removed from the underlying complex

computer interchanges which are driving it.  This world has been called CYBERSPACE.

Further reading:

For further background on Internet history visit:

http://www.isoc.org/Internet/history/index.shtml

For a glossary of Internet terms, visit:

http://www0.delphi.com/navnet/glossary/index.html

The history and development of the World Wide Web according to Mr. Berners-Lee:

http://www.w3.org/People/Berners-Lee/FAQ.html

                                                
5a transfer protocol is a standard set of instructions which two computers execute in order
to transfer information with each other.  Common examples are the "http" protocol
(hypertext transfer protocol) and the "ftp" protocol (file transfer protocol).

http://www.isoc.org/internet/history/index.shtml
http://www0.delphi.com/navnet/glossary/index.html
http://www.w3.org/People/Berners-Lee/FAQ.html
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 Chapter IV - Internet Basics

The Browser

The explosion in use of the Internet occurred with the introduction of very functional and

user-friendly software to “browse” or “surf” the information sites.   The need for such

software was obvious to users in the early days of the World Wide Web.   Many useful

programs were developed but eventually browsers from Netscape (Netscape Navigator)

and Microsoft (Internet Explorer) became widely used.  Netscape and Microsoft browsers

operate similarly and are comparable in function and quality.

In this paper we will use the Netscape Navigator browser to illustrate the principal

functions of Internet browsing:

• Visiting a World Wide Web site

• Navigating (Back, Forward, History)

• Bookmarking sites for future re-visiting

• Saving and Printing pages

• Sending and receiving E-mail and attachments

• Using Adobe Acrobat

Getting Connected

Your Internet Service Provider (ISP) will help you get your computer set up and

connected to the Internet.  In this seminar, you will be directly connected to the Internet

through a local area network.  This is type of connection is highly recommended for an

office environment as it provides the most reliable, easiest to use and fastest type of

connection.  

At home you will not be connected directly to a network, so you will have to connect via

telephone to your ISP using the dial-up networking function available on your Windows

95/98 or Macintosh computer.

http://www.infoseek.com/
http://www.altavista.com/
http://www.askjeeves.com/
http://www.lycos.com/
http://www.excite.com/
http://www.lawrunner.com/
http://lawcrawler.findlaw.com/
http://gsulaw.gsu.edu/metaindex/
http://jurist.law.utoronto.ca/
http://www.lexicongraphics.com/scdla.htm
http://www.qp.justice.gov.sk.ca/
http://canada.justice.gc.ca/Loireg/index_en.html
http://www.qp.gov.bc.ca/bcstats/index.htm
http://www.gov.ab.ca/qp/indiv.html
http://www.gov.mb.ca/chc/statpub/login.html
http://www.attorneygeneral.jus.gov.on.ca/legimenu.htm
http://doc.gouv.qc.ca/html/lois_regle_tele_mots_cles.html
http://doc.gouv.qc.ca/gazette/html/gazette_officielle.html
http://www.gov.ns.ca/legi/legc/srch_sol.htm
http://founder.library.ualberta.ca/Yukon/index_en.html
http://www.droit.umontreal.ca/doc/cscscc/en/index.html
http://www.quicklaw.com/en/recent/scc.html#mostrecent
http://www.fja-cmf.gc.ca/en/cf/index.html
http://www.lawsociety.sk.ca/database.htm
http://www.ecarswell.com/
http://supct.law.cornell.edu/supct/
http://www.law.emory.edu/FEDCTS/
http://www.corporations.justice.gov.sk.ca/
http://strategis.ic.gc.ca/sc_mrksv/cipo/welcome/welcom-e.html
http://www.uspto.gov/
http://canada.gc.ca/
http://www.gov.sk.ca/
http://www.open.gov.uk/
http://www.oecd.org/
http://ctn.nrc.ca/
http://www.ntis.gov/index.html
http://nctn.hq.nasa.gov/
http://dpa.state.ky.us/~rwheeler/medicine.htm
http://www.expertpages.com/
http://www.experts.com/
http://www.mysask.com/search/whitesearch.shtml
http://canada411.sympatico.ca/
http://www.canoe.com/
http://www.nationalpost.com/
http://www.theglobeandmail.com/
http://www.saskstar.sk.ca/index.html
http://www.leader-post.sk.ca/
http://www.smithlyons.com/
http://www.heenanblaikie.com/
http://www.robertsonstromberg.com/
http://www.lawsonlundell.com/
http://www.bennettjones.ca/
http://www.boyneclarke.ns.ca/
http://www.legalaction.com:/
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The Browser Interface

The browser main screen provides the user with all of the tools to navigate the Web.

Enhancements or features that are not common to both major browsers (Netscape and

Microsoft) will not be examined in detail.

This is the browser screen as it may look when you first enter Navigator:

To begin we will look at the basic navigation functions:

• Location window (white space, top - middle of screen)

• Site display window (in this case, the University of Saskatchewan)

• Back and Forward buttons (top left)

• Bookmarks button (top left below Back and Forward buttons)

The location window tells the user the Internet Location of the displayed web page. To

visit another web page, you may enter the Internet location of the web page directly in

this window and press the Enter key.

http://www.usask.ca
http://www.usask.ca
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Example:  Point your mouse on the Location Window and delete the characters after

“www.”.  Then enter the words:  “lawsociety.sk.ca”.  You should see a screen similar to

this:

When you did this, your browser contacted the Law Society server and requested the web

page located at “http://www.lawsociety.sk.ca”, received it and then displayed it.  The

term: “http://www.lawsociety.sk.ca” is known as the URL (Universal Resource Locator)

for the site.6

                                                
6 Actually, when you entered this URL and pressed the “enter” key, the browser sent a
packet of information addressed to the Domain Name Service (DNS) server in your area
requesting the Internet Protocol Address (IP address) for the URL
“http://www.lawsociety.sk.ca”.  The DNS server looked it up and sent back the unique IP
address 207.195.119.75.  That took about half a second.  Then the browser sent a packet
containing a request bearing that IP address (which is the IP address of the Law Society’s
server).  The Law Society server sent out the web page description with your computer’s
IP address on it.  Your browser received and displayed it.
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Internet location URLs have the following parts:

transfer protocol:    http://  (This tells the destination computer to respond using the

hypertext transfer protocol)

domain name: www.lawsociety.sk  (this is the unique Internet name for the Law

Society web server)

top level domain: .ca  (this tells the DNS server which top level domain to search

for the domain name:  www.lawsociety.sk)

The most common top level domain is “.com”.  Other common ones are: “.net”, “.edu”,

“.gov” and “.org”.   Geographical top level domains exist for every country.   The “.ca”

top level domain is for Canada.

Using the Back and Forward buttons

Press the “Back” button.  You should return to the previous screen.  Press the Forward

button.  You should return to the Law Society home page.

Bookmarking URLs.

You may wish to return to a site.   To “bookmark” the site being displayed, simply press

the “Bookmarks” button and select “Add Bookmark”. (Or “File Bookmark”)
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To organize your bookmarks, press the Bookmarks button and select “Edit Bookmarks”.

In the Edit Bookmarks screen can move bookmarks around by clicking and dragging

them and you may create folders using File>New Folder.

To later return to a site that you have book-marked, simply press the Bookmarks button

and click on the bookmarked entry that appears in the drop down list.

Printing Web Pages

You may wish to print the information displayed in the current web page.  To print, press

the print button and select the pages you wish to print. Because a web “page” is

continuous from beginning to end, it may print over several paper pages.  The browser

does not tell you how many printed pages will result so this causes some difficulty if you

only wish to print a portion of the web page.  A well-designed web site will usually

display information in short web pages.

Saving Web Pages

You may wish to save information displayed in the browser display window. For

example, you may wish return to pages that have been found from a searchable database

such as e-carswell . These pages usually cannot be bookmarked.  The easiest way to

return to the page is to save it to your hard drive.

To save the web page currently being displayed select File>Save As from the file menu,

enter a file name and location on your hard drive.  Press Save.  Note:  Saving a page will

not save graphic images that are displayed with the text of the page.  It will only save the

text portion.
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E-mail

E-mail is like mail, with e-mail servers being the Post Offices.  An e-mail box is simply a

folder residing on the e-mail server - a software analog to a post office box.  To send an

e-mail message to a person, you must identify the Box and the Post-Office (by its Internet

domain).  The message is sent to the e-mail server and the server places it in the user’s

box or folder.  This makes it available to the user when the user logs in to check his or

her mail.

The e-mail address contains the mailbox and the domain separated by the symbol: @

mailbox@domain

Examples:
a.mason@dufourlaw.com
sbaer@lawsociety.sk.ca
aih@radio.cbc.ca

Receiving and Sending E-mail

E-mail is available from your browser. (It is actually a separate program and uses a

different part of the Internet than the World Wide Web).  To access e-mail from

Netscape, click on the “envelope” icon in the icon bar on the bottom right window in the

Netscape browser.

The e-mail screen will appear.  Provided you have set up the e-mail program correctly

with your e-mail particulars, the e-mail program will automatically check your e-mail

box and prompt you for a password (if you have not asked it to save your password).

E-mail Icon
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New e-mail messages will automatically be downloaded from your e-mail server to your

Inbox.

The e-mail screen consists of three parts:

• the box selection window
• the header window
• the message window

Just click on the message header in the header window and the message will appear in the

message window.  You can print the message by clicking the Print button.

To receive e-mail, you may wish to set up your e-mail preferences to regularly check for

e-mail (say every 30 minutes).  Or you can simply press the “Get Msg” button (top left)

to retrieve any new messages.  That is essentially all there is to receiving e-mail.7

Anatomy of the Netscape E-Mail Window

header
window

message
window

mail box
selection
window
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To send e-mail, press the “New Message” button to see the composition window.

The Composition window.  Composing and Sending an e-mail message.

To compose and send an e-mail message, enter the addressee’s e-mail address, comp

the subject and message and press the Send button.  It is that simple.

To view sent messages (i.e. messages you have sent to others), select the “Sent” option

the mail box selection window (top left - shown above displaying the word “Inbox

You will see a list of headers of all the e-mail messages you have sent in the hea

window.

As you use e-mail, you will likely wish to make use of functions such as the Addr

Book, saving drafts.   Feel free to try these features out on your own.

                                                                                                                                           
7  Note that the process of “getting” the message simply transfers the e-mail message from the
mail box on the remote mail server to your computer (it usually deletes the message on the
server at the same time, but you can change the settings to prevent this deletion).

4. press
send
1. enter
the email
address
ose

 in

”).

der

ess

     
 e-

2. enter
subject

3. enter
message
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E-mail Attachments

You will likely wish to send and receive attachments - files containing word processing

files, photographs, PDF files etc.  By attaching files to your e-mail messages, you are

able to easily send and receive computer files.

To send an e-mail with an attachment, press the “New Message” button and bring up the

Composition window.  Add the e-mail address and then press the “Attach” button.  Select

“File”:

In the resulting dialog box (see next page), locate and select the file that you wish to send

to the addressee and press the “Open” button. The filename will appear in the Attachment

line in the top portion of your e-mail composition window confirming that it is attached

to this message. Compose and send the message as you would normally do. The

addressee will receive the message and the attached file.
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Select the file you wish to send by locating and selecting it in the file selection dialog box

The file name of the attached file appears in the Attachment field in the header (press the

paper clip icon).



Page 30

To receive an attachment, the user must be able to locate and save the attached file. In

order to view the attached file, the user must have the software needed to view the file

installed on the computer.

Email display window of a received e-mail message with a document attachment.

In this example, we have attached the file, “New Text Document.txt”.  You should save

this file to a folder so you can find it later and view it or edit it.  To save it, click the right

mouse button while holding the mouse pointer over the blue file name “New Text

Document.txt” in the box at the bottom of the display window.

You will see a pop-up menu with several options (see diagram on the next page).  Select

“Save Link As”.  Enter the folder location where you wish to store the file, type in a file

name and press the “Save” button.
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Place the mouse pointer here and press the Right mouse button to display pop-up menu

The file that the sender attached to the e-mail message will be saved to a file on your

computer hard drive with the file name you entered and located in the folder you selected.

You may later view and edit the attached file that you just saved.

E-mail attachments can be any kind of file: text, graphics, audio, video, photographs.

Again, however, to view / hear / read the attached file, the recipient must have the

software required to handle the specific type of file.
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Portable Document Format (Adobe Acrobat)

The difficulty most often encountered in sharing documents is the need to have installed

on the destination computer the same software (and often the same version of software)

with which the original document was created.  Although word processing programs can

often convert a document from one format to another, this often is not the case.  Even

where the document can be converted, formatting information is invariably lost or

changed and the recipient is not able to print the document to look like the original.

The Portable Document Format developed by Adobe Systems Inc. is the solution to this

problem.  A highly formatted document can be saved in PDF format, attached to an e-

mail and viewed and printed by the recipient with results that are identical to the original.

Using the free Adobe Acrobat Reader (included with this manual), the user is able to

view and print the document without any loss of information, formatting or quality.

There are other advantages to PDF format.  The documents can contain links to web

locations or other documents.  Text can be searched.  Indexes can be created to allow

very rapid searching over entire collections of documents.

More and more organizations are using PDF documents to distribute legal information:

Statutes, Gazettes, Rules of Court, cases, forms, and other kinds of information are being

distributed in PDF format.  PDF is becoming, if it has not already become, the de facto

world standard for electronic document interchange.

It is, therefore, very important that the lawyer understand how to use the Adobe

Acrobat Reader.
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The Queen’s Printer, Saskatchewan

All Queen’s Printer documents - Statutes of Saskatchewan, Gazettes, Rules of Court, and

Bills before the Legislature - are available only in PDF form.  This is ideal, because:

• the documents, when viewed and printed, look exactly the same as the official

Queen’s Printer version;

• the text can be searched (using the Acrobat search function);

• the text can be selected and copied into any word processing program;

• with the full version of Adobe Acrobat, the user can add links to navigate easily

through or between documents  (this is particularly useful for long statutes or Rules

that the lawyer uses frequently).

Exercise

 Navigate through the Automobile Insurance Act using the Arrow

buttons in the Acrobat toolbar:

 Find a section in the Automobile Insurance Act in which the word

“alcohol” is mentioned.

• Start Adobe Acrobat Reader and load the Automobile Accident

Insurance Act.  If your are viewing this file in Acrobat, just click

on the above “hyperlink” or just click here.

• Select Edit>Find from the menu bar

• type “alcohol” as the search term (Find what:) and press

“Enter”

 Copy the section containing “alcohol” to a document in Wordpad

• Open Wordpad

• Switch back to the Acrobat Reader by selecting the Acrobat Icon

in the Taskbar (bottom)

• Click on the “text” icon from the tool bar :
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• Select the text that you wish to copy (all or part of the section

containing the word “alcohol”

• Select Edit>Copy (or press Ctrl C)

• Return to the blank Wordpad document and select Edit>Paste (or

press Ctrl V)

Play around with a PDF document in Adobe Acrobat and learn how to use this software.

Your skill in using Acrobat will become invaluable to you.
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Chapter V : The Internet for Lawyers

Cyberspace and the Practice of Law

The Internet is a medium for social interaction on a world-wide scale. The Internet

provides an inexpensive and very effective medium for the sharing and distribution of all

types of information.  More information is now carried via the Internet than any other

communications network, including the telephone system. It will soon replace the

telephone system as telephone companies integrate secure voice communication with the

Internet.

A lawyer today asking: “What can I possibly use the Internet for?” is like the 19th century

lawyer asking what use can be made of the telephone.

Using a computer connected to the Internet, a lawyer can:

1. access information quickly without having to go through human bureaucracies and
slow delivery systems.  For example:

• Statutes and regulations, Gazette publications, Bills
• Court judgments
• Government information

• Corporations branch information (and eventually, PPR and Land Titles)
• trade marks and patents
• Immigration forms and information

• scientific and technical information
• information on how to find an expert
• people, addresses and phone numbers

2. communicate with clients and others via e-mail - exchange text, voice, and visual
information - quickly and cost-effectively

3. publish information - for potential or existing clients (such as  the services the
lawyer provides)
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Access to Information

Once connected to the Internet, the lawyer is only a few mouse clicks away from

information in graphical, photographical, text, audio and video form - on virtually any

subject imaginable.

Information can be located using:

• general search engines such as
Infoseek: http://www.infoseek.com

Alta Vista: http://www.altavista.com

Ask Jeeves:  http://www.askjeeves.com

Lycos:  http://www.lycos.com

Excite:  http://www.excite.com

• specialized search engines such as the following for law:
The LawRunner site: http://www.lawrunner.com/

The FindLaw search tool:  http://lawcrawler.findlaw.com/

The U.S. Meta-Law search facility: http://gsulaw.gsu.edu/metaindex/

• links provided by special information sites and referring lists:
Jurist Canada:  http://jurist.law.utoronto.ca/

Saskatoon Criminal Defence Lawyers Association - Criminal Law

Links:  http://www.lexicongraphics.com/scdla

Here are some examples of sites useful to lawyers;

• Statutes, Regulations, Bills: Federal and provincial statutes are available on the
Web.  All statutes are searchable and retrievable.

The Province of Saskatchewan Queen’s Printer has a great site for
distributing statutes, regulations and Saskatchewan Gazette information as
well as the rules of court. The information is contained in downloadable
files in a format called “portable document format” that allows the user to
print out documents identical to the published version.  This site is well
serviced and up to date.  It is well worth the annual access fee:

http://www.qp.justice.gov.sk.ca/

The Federal Department of Justice has made federal statutes available on
the web at its free site.  Statutes are at least 6 months old and do not print

http://www.infoseek.com/
http://www.altavista.com/
http://www.askjeeves.com/
http://www.lycos.com/
http://www.excite.com/
http://www.lawrunner.com/
http://lawcrawler.findlaw.com/
http://gsulaw.gsu.edu/metaindex/
http://jurist.law.utoronto.ca/
http://www.lexicongraphics.com/scdla
http://www.qp.justice.gov.sk.ca/
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in the Queen’s printer format.  Regulations are also available, but Canada
Gazettes are not (yet).

http://canada.justice.gc.ca/Loireg/index_en.html

Other provinces have made their statutes available on the Web:

 B.C. Statutes -- (consolidated to October 31, 1997)

http://www.qp.gov.bc.ca/bcstats/index.htm

 Alberta Statutes

http://www.gov.ab.ca/qp/indiv.html

 Manitoba Statutes

http://www.gov.mb.ca/chc/statpub/login.html

 Ontario Statutes

http://www.attorneygeneral.jus.gov.on.ca/legimenu.htm

 Quebec Statutes (in french)

http://doc.gouv.qc.ca/html/lois_regle_tele_mots_cles.html

 New Brunswick Statutes

http://inter.gov.nb.ca/justice/ASRLSTE.HTM

 Nova Scotia Statutes

http://www.gov.ns.ca/legi/legc/srch_sol.htm

 Yukon Territory Statutes

http://founder.library.ualberta.ca/Yukon/index_en.html

• Court Judgments:

 The judgments of the Supreme Court of Canada are available at:

http://www.droit.umontreal.ca/doc/cscscc/en/index.html

Supreme Court judgments are also available at the Quick Law Web site:

http://www.quicklaw.com/en/recent/scc.html#mostrecent

 The Federal Court of Canada: http://www.fja.gc.ca/en/cf/decisions.html

 The Law Society of Saskatchewan site contains digests and full text versions
of all decisions of all Saskatchewan Courts (annual fee for access to cases):

 http://www.lawsociety.sk.ca/

 The Carswell Company (fee service) : http://www.ecarswell.com/

 The U.S. Supreme Court decisions: http://supct.law.cornell.edu/supct/

http://canada.justice.gc.ca/Loireg/index_en.html
http://www.qp.gov.bc.ca/bcstats/index.htm
http://www.gov.ab.ca/qp/indiv.html
http://www.gov.mb.ca/chc/statpub/login.html
http://www.attorneygeneral.jus.gov.on.ca/legimenu.htm
http://doc.gouv.qc.ca/html/lois_regle_tele_mots_cles.html
http://inter.gov.nb.ca/justice/ASRLSTE.HTM
http://www.gov.ns.ca/legi/legc/srch_sol.htm
http://founder.library.ualberta.ca/Yukon/index_en.html
http://www.droit.umontreal.ca/doc/cscscc/en/index.html
http://www.quicklaw.com/en/recent/scc.html#mostrecent
http://www.fja.gc.ca/en/cf/decisions.html
http://www.lawsociety.sk.ca/
http://www.ecarswell.com/
http://supct.law.cornell.edu/supct/


Page 38

 U.S. Federal District Courts judgments: http://www.law.emory.edu/FEDCTS/

• Corporations Branch Information

Saskatchewan Corporations Branch searches:
http://WWW.corporations.justice.gov.sk.ca/

• Patents and Trademarks

Canadian Intellectual Property Office (Trademarks and Patents):
http://strategis.ic.gc.ca/sc_mrksv/cipo/welcome/welcom-e.html

U.S. Patent and Trademark Office:
http://www.uspto.gov/

• Governments:

Government of Canada
http://canada.gc.ca/

Government of Saskatchewan
http://www.gov.sk.ca/

Government of the United Kingdom:
http://www.open.gov.uk/

Organization for Economic Co-operation and Development
http://www.oecd.org/

• Scientific, Technical, Medical information

Canadian Technology Network:
http://ctn.nrc.ca/

U.S. National Technical Information Service (NTIS):
http://www.ntis.gov/index.html

NASA Commercial Technology Network
http://nctn.hq.nasa.gov/

Forensic medicine links:
http://dpa.state.ky.us:80/~rwheeler/medicine.htm

http://www.law.emory.edu/FEDCTS/
http://www.corporations.justice.gov.sk.ca/
http://strategis.ic.gc.ca/sc_mrksv/cipo/welcome/welcom-e.html
http://www.uspto.gov/
http://canada.gc.ca/
http://www.gov.sk.ca/
http://www.open.gov.uk/
http://www.oecd.org/
http://ctn.nrc.ca/
http://www.ntis.gov/index.html
http://nctn.hq.nasa.gov/
http://dpa.state.ky.us/~rwheeler/medicine.htm
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• Locating experts.

A couple of examples (U.S.):
The Experts pages:  http://www.expertpages.com/
The Experts: http://www.experts.com/

• Phone numbers:

Saskatchewan phone numbers listings:

http://www.mysask.com/search/whitesearch.shtml

Other provinces except Alberta:  http://canada411.sympatico.ca/

• News:

Canada canoe:  http://www.canoe.com/

National Post: http://www.nationalpost.com/

Globe and Mail: http://www.theglobeandmail.com/

Saskatoon StarPhoenix: http://www.saskstar.sk.ca/index.html

Regina LeaderPost:  http://www.leader-post.sk.ca/

Communicating via E-mail

Clients are gradually discovering e-mail as a means of communicating directly with their

lawyer. The ease of use, cost efficiency and timely turn-around of written com-

munications creates obvious advantages.  E-mail allows lawyers and clients to easily

exchange correspondence and documents as well as other types of information such as

photographs and audio or video clips.   E-mail programs are quite easy to use and have

many features which take the drudgery out of correspondence.  The documents you send

are all in computer readable text so your client can send you back his/her own revisions.

Computer literate clients are expecting their lawyers to be computer literate e-mail users.

Lawyers who are not, will eventually lose clients.  What would happen if you told your

client you did not understand how to use the telephone?

http://www.expertpages.com/
http://www.experts.com/
http://www.mysask.com/search/whitesearch.shtml
http://canada411.sympatico.ca/
http://www.canoe.com/
http://www.nationalpost.com/
http://www.theglobeandmail.com/
http://www.saskstar.sk.ca/index.html
http://www.leader-post.sk.ca/
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Publishing to the World

The Web offers enormous opportunities to the entrepreneurial lawyer.  Establishing a

presence on the web gives the lawyer the ability to create a professional image and to

keep that image current and accessible to potential clients.

Examples of some law firm sites:

Smith Lyons, Toronto: http://www.smithlyons.com

Heenan Blaikie, Montreal:   http://www.heenanblaikie.com

Robertson Stromberg, Saskatoon:  http://www.robertsonstromberg.com

Lawson Lundell, Vancouver: http://www.lawsonlundell.com/

Bennett Jones, Calgary:  http://www.bennettjones.ca/

Boyne Clarke, Halifax: http://www.boyneclarke.ns.ca/

The web site as a tool for managing large scale Litigation / The Class
Action

Consider the situation where a large number of people may have a very similar cause of

action (e.g. breast implant litigation, smoking cases, vanishing premiums life insurance,

developer fraud).  An entrepreneurial lawyer can tell the world that he/she intends to start

a class action or an action on behalf of a client and invite any potential plaintiff apply to

become a party to the action.
• 

Once started, a web site can be a very effective and inexpensive means of ensuring all

parties are informed of developments in the action and of receiving new information from

parties or interested persons.

Example:

http://www.legalaction.com: A well-developed site relating to a particular class

action involving developer fraud.  Documents including all court documents, sound

recordings, photographs and a chronicle of events in the action

http://www.smithlyons.com/
http://www.heenanblaikie.com/
http://www.robertsonstromberg.com/
http://www.lawsonlundell.com/
http://www.bennettjones.ca/
http://www.boyneclarke.ns.ca/
http://www.legalaction.com:/
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How will the Internet impact the Practice of Law?

During the next decade, the Internet will likely become the single most important means

by which information is shared and distributed throughout the world.   There will be an

increasing benefit for those who have been able to use the technology effectively.

But to make it work, technology must be used effectively to improve the quality of

services that lawyers provide and to contribute to the development of the law and the

legal profession.  The technology is not an end in itself.

As Roberta Cooper Ramo, past-president of the American Bar Association wrote in her

address: The Changing Practice of Law in an Electronic Environment8

What will matter most then is the quality of what lawyers use
technology for rather than the ability to master the technology
itself. Our challenge as lawyers is to devise ways to use
technology to better our profession, to better help our clients and
to better carry out our roles as officers of the court.

© Andrew M. Mason
December 1999

                                                
8http://www.nysba.org/media/barjournal/ramo.html

http://www.nysba.org/media/barjournal/ramo.html
mailto:a.mason@dufourlaw.com
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